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Disclaimer

SICK uses standard IP technology in its products, for example 
IO-Link. The emphasis is placed on availability of products and 
services. SICK always assumes that the integrity and confidentiality 
of the data and rights affected by the use of the aforementioned 
products will be ensured by the customer.

In all cases, appropriate security measures, such as network 
separation, firewalls, virus protection, and patch management, 
must be taken by the customer based on the situation in question.

Cybersecurity

To protect against cybersecurity threats, it is necessary to 
continuously monitor and maintain a comprehensive and holistic 
cybersecurity concept. A suitable concept comprises organiza-
tional, technical, procedural, electronic, and physical levels of 
defense and provides suitable measures for different types of risks. 
Products and solutions from SICK must be viewed as a component 
of this concept.

You can find more information about cybersecurity at:  
www.sick.com/psirt

Safety

b	The Visionary-S AP does not constitute personal protection 
equipment in accordance with the respective applicable safety 
standards for machines.

b	The mounting, electrical installation and configuration of the 
device must only be carried out by professionally qualified 
personnel.

b	When mounting and electrical installation work is being carried 
out, always comply with standard operating procedures, and 
applicable health and environmental regulations.

b	The camera is not suitable for use outdoors or in explosion-
hazardous areas.

b	When installing the device, always consider the electrical 
connected loads.

b	Replace faulty or damaged cables and male connectors 
immediately.

b	Replace damaged or faulty components immediately and in 
consultation with SICK AG.

b	When mounting the device, it is imperative that you use suitable 
mounting equipment and that you consider their specific 
tightening torques. The mounting equipment must be self-locking 
or secured appropriately.

b	Ensure a constant voltage supply to the device within the set 
parameters.

b	Operate the 3D camera only within the set operating parameters.

b	Regularly check that the 3D camera is functioning properly.

b	The infrared beams of the laser illumination unit do not pose a 
danger to the human eye if the 3D camera is operated within the 
specified parameters (laser class 1, EN/IEC 60825-1:2007,  
IEC 60825-1:2014, EN 60825-1:2014+A11:2021).

b	Structural modifications to the 3D camera are strictly forbidden!

b	During mounting, ensure there are no attachment parts in the 
detection volume of the 3D camera.

Optical radiation: Laser class 1

The accessible beam from the laser illumination unit integrated 
into the device does not pose a danger when exposed directly for 
up to 100 seconds. It may pose a hazard to the eyes and skin in 
the event of incorrect use.

b	Do not open the housing. Opening the housing may increase the 
level of risk.

b	Applicable national regulations regarding laser protection must 
be observed.

Scope of delivery

b	Visionary-S AP (3D camera) 

b	This product documentation

Product features

b	Access to 3D/RGB image data

b	Meets industrial requirements for data security and reliability

b	Easy mounting and commissioning

b	3D data acquisition at up to 30 fps

b	Can be used in any indoor space

b	Visionary-S AP as a parameterizable Key App enabler: in 
combination with Key Apps, intended for users who want to solve 
certain application problems without having to develop their own 
software solution. 

b	Visionary-S AP as a programmable device: intended for 
programmers who develop machine vision applications based on 
Visionary data and want to run these directly on a device.

   CAUTION

Overview

Visionary-S AP is a 3D color camera based on the stereo principle 
with structured lighting. The 3D camera delivers real-time 3D data 
at 30 frames per second (fps).

The SICK AppStudio development environment is needed (license 
required) for the programmable device version of Visionary-S AP.

To run Visionary-S AP as a parameterizable device in combination 
with a SensorApp, you need SICK AppManager (license-free). 

Usage overview:

1.	 Complete mechanical and electrical setup.

2.	 Install SICK AppManager or SICK AppStudio.

3.	 Connect device with SICK AppManager or SICK AppStudio.

4.	 Parameterize device or start programming.

Performing the mechanical and electrical 
setup

1.	 Secure the inner clamp to the outside edge (1). Attach the 3D 
camera (2) and secure it using the fitting screws (3).

2.	 Prepare the mounting position as per dimensional drawing  A .

3.	 Mount the 3D camera in the proper alignment for the desired 
detection volume  C .

4.	 Connect the Ethernet interface of the 3D camera directly 
to the computer or to the network to which the computer is 
connected.

5.	 To establish the voltage supply and the signal transmission, 
use the system plug of the 3D sensor  B .

System requirements

Operating systems:

b	Windows 10, 4 GB-RAM

b	Windows 8 Professional (32/64 Bit), 4 GB RAM

b	Windows 7 Professional (32/64 Bit), 4 GB RAM

Minimum Core i5, 2.6 GHz or equivalent

Free hard disk space: 450 MB

Ethernet: 100 MBit/s or higher

Depending on the visualization requirements for the generated 
data, additional graphics hardware may be required.

Browser: Google Chrome is recommended due to its extended 
support of WebGL and WebSockets.

Installation of SICK AppManager or SICK 
AppStudio

SICK AppManager is a configuration software for the installation 
and re-provisioning of SensorApps. The SICK AppStudio develop-
ment environment is used to program the device. Administrator 
rights are required to install the software on a computer.

License

SICK AppManager is a license-free tool. A valid license is required 
to download and use SICK AppStudio. You can purchase a one-year 
license at www.sick.com (part number 1610199).

Installation

1.	 Log in to the SICK Support Portal at supportportal.sick.com. 
Register a user account before logging in for the first time.

2.	 Download the current version of SICK AppManager or SICK 
AppStudio.

3.	 Run the installation file. Follow the instructions.

When using SICK AppStudio for the first time, enter or load your 
personal license key to complete the installation. If the license 
dialog box does not open automatically, select the “License” option 
in the “Help” menu. SICK AppManager can be used immediately 
after installation (no license key required).

Starting SICK AppStudio

1.	 Connect the device to the computer via Ethernet.

2.	 Configure the computer so that it is on the same subnet 
as the device but has a different IP address. The default IP 
address for the device is 192.168.1.10.

3.	 Start SICK AppStudio. The connection wizard then starts 
automatically and scans for available devices.

4.	 Select the device from the list of available devices.

5.	 Click Connect.

First steps with the device

The Visionary-S AP comes with the preinstalled application 
Visionary_S_AP_SplitViewer, which displays a 2D intensity image 
and a 3D point cloud visualization. The SplitViewer app runs 
automatically immediately after switching on the device. The app 
can be used independently of SICK AppStudio or parallel to SICK 
AppStudio.

Open SplitViewer:

1.	 Open a web browser.

2.	 Enter the IP address of the device in the address field. The 
default IP address is 192.168.1.10.

Control elements for image manipulation

The control elements for image manipulation are used to interact 
with the image in the viewer (resizing, moving).

In addition to the buttons, there are also shortcut links available.

Button Designa-
tion

Description

Select To display the coordinates and the 
respective pixel intensities, point at an 
area with the mouse. To change the 
size of the ROI, click and drag the area.

Move Click and drag to move the image.

Key combination: Press and hold the 
Shift key.

Rotate Click and drag to rotate the image.

Key combination: Press and hold CTRL. 

Zoom Click and drag upwards to zoom in. 
Click and drag downwards to zoom out.

Key combination: Use the mouse scroll 
wheel.

3D navigation control

To switch between orthographic 2D and 3D viewing angles, use the 
3D navigation control in the bottom left corner of the viewer.

b	To display a 2D projection of the object, click on an arrowhead (X, 
Y or Z).

b	To rotate the 2D projection (e.g. switch between the top and 
bottom view of the Z axis), double-click the same arrowhead.

b	To return to the original display position, click on Home.
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Menus

The View, Color and Options menus in the 3D viewer contain options 
for the visualization of point cloud data. 

Use X, Y, Z or Intensities in the View menu to select different views 
for the data. 

Use the Color menu to select the desired color of the color 
gradient. 

The “Points” menu item in the “Options” menu displays data in 
a point representation. Use the slider to change the size. The 
“Lighting” and “Surface” options are not currently used.

Using SICK AppStudio

Tutorials

Tutorials on general and device-specific topics are available to 
assist users with programming the device. The relevant tutorials for 
the Visionary-S AP are available at supportportal.sick.com in the 
SICK Support Portal.

Lua scripts

The embedded script language “Lua” is used to generate scripts 
in SICK AppStudio. You can find additional information on “Lua” at 
www.lua.org.

Autocomplete

SICK AppSpace provides a comprehensive API with functions for 
hardware parameterization, algorithms, result processing and 
result communication. The API can be accessed directly via the 
Lua scripts:

1.	 Click on an empty spot in the Lua file.

2.	 To display a list of all accessible functions and commands for 
the device, press CTRL+spacebar.

The API documentation for the device is available at  
supportportal.sick.com in the SICK Support Portal.

SICK AppStudio interface

Starting SICK AppManager

1.	 Connect the device to the computer via Ethernet.

2.	 Configure the computer so that it is on the same subnet 
as the device but has a different IP address. The default IP 
address for the device is 192.168.1.10.

3.	 Start SICK AppManager. The system then scans for available 
devices by default.

4.	 To establish the connection, click on the device in the list of 
available devices

SICK AppManager interface

Starting SICK AppManager

Example Key App interface provided by SICK AppManager

Service and maintenance

The 3D camera contains no inner parts that the user needs to 
have serviced.

b	Check the screw connections and terminals regularly.

b	Clean the housing using a soft cloth. Either use a dry cloth, or 
dampen it with lukewarm water and a small amount of mild 
cleaning agent.

b	Clean the areas between the cooling ribs regularly.

Additional information

More information can be found on the product page.

The page can be accessed via the SICK Product ID: pid.sick.
com/{P/N}/{S/N}

{P/N} corresponds to the part number of the product, see type 
label.

{S/N} corresponds to the serial number of the product, see type 
label (if specified).

The following information is available depending on the product:

•	 Data sheets

•	 This document in all available language versions

•	 CAD files and dimensional drawings

•	 Certificates (e.g., declaration of conformity)

•	 Other publications

•	 Software

•	 accessories

For additional information on the 3D camera, visit supportportal.
sick.com or see the online help for SOPAS ET.

Please contact your local sales office in the event of any support 
queries.

Software licenses

SICK uses open source software which is published by the rights 
holders under a free license. Among others, the following license 
types are used: GNU General Public License (GPL version 2, 
GPL version 3), GNU Lesser General Public License (LGPL), MIT 
license, zlib license and licenses derived from the BSD license.

This program is provided for general use without warranty of 
any kind. This warranty disclaimer also extends to the implicit 
assurance of marketability or suitability of the program for a 
particular purpose.

See the GNU General Public License for more information.

For the license text, see www.sick.com/licensetexts. Printed 
copies of the license texts are also available on request.

Detailed addresses and further locations at www.sick.com

Australia 
Phone	 +61 (3) 9457 0600 
	 1800 33 48 02 – tollfree
Austria 
Phone	 +43 (0) 2236 62288-0
Belgium/Luxembourg 
Phone 	 +32 (0) 2 466 55 66
Brazil 
Phone	 +55 11 3215-4900
Canada 
Phone	 +1 905.771.1444
Czech Republic 
Phone	 +420 234 719 500
Chile 
Phone	 +56 (2) 2274 7430
China 
Phone	 +86 20 2882 3600
Denmark 
Phone	 +45 45 82 64 00
Finland 
Phone	 +358-9-25 15 800
France 
Phone	 +33 1 64 62 35 00
Germany 
Phone	 +49 (0) 2 11 53 010
Greece  
Phone	 +30 210 6825100 
Hong Kong 
Phone	 +852 2153 6300
Hungary 
Phone	 +36 1 371 2680
India 
Phone	 +91-22-6119 8900
Israel 
Phone	 +972 97110 11 
Italy 
Phone	 +39 02 27 43 41
Japan 
Phone	 +81 3 5309 2112
Malaysia 
Phone	 +603-8080 7425
Mexico 
Phone	 +52 (472) 748 9451

Netherlands 
Phone	 +31 (0) 30 204 40 00
New Zealand   
Phone	 +64 9 415 0459 
	 0800 222 278 – tollfree
Norway   
Phone	 +47 67 81 50 00
Poland 
Phone	 +48 22 539 41 00
Romania 
Phone	 +40 356-17 11 20
Singapore 
Phone	 +65 6744 3732
Slovakia 
Phone	 +421 482 901 201
Slovenia 
Phone	 +386 591 78849
South Africa 
Phone	 +27 10 060 0550
South Korea 
Phone	 +82 2 786 6321/4
Spain 
Phone	 +34 93 480 31 00
Sweden 
Phone	 +46 10 110 10 00
Switzerland 
Phone	 +41 41 619 29 39
Taiwan 
Phone	 +886-2-2375-6288
Thailand 
Phone	 +66 2 645 0009
Turkey 
Phone	 +90 (216) 528 50 00
United Arab Emirates 
Phone	 +971 (0) 4 88 65 878
United Kingdom 
Phone	 +44 (0)17278 31121
USA 
Phone	 +1 800.325.7425 
Vietnam 
Phone	 +65 6744 3732

http:// www.sick.com
http://supportportal.sick.com
http://supportportal.sick.com
http://www.lua.org
http://supportportal. sick.com


Voltage/digital I/O/service 
(17-pin, M12, system plug)

Gigabit Ethernet 
(8-pin, M12, X-coded)

 E 

 D 

Visionary-S AP

Device Description

Blue – flashing slowly System start

Green In operation 

Orange – flashing slowly Device warning

Red – flashing slowly Error condition

 B  Connections

Technical data

Status LEDs

 A  Dimensional drawings in mm [inch]

Part no. Description Part no. Description
2077709 2x screws, 2x clamps 6051194 M12 cable, 2A, Ecolab, 3 m (CDB650)

2077710 Mounting kit (2-part) incl. clamps 2070425 M12 cable, 2A, Ecolab, 3 m

2106258 Ethernet cable 2 m, M12 / RJ45, X-coded 2070426 M12 cable, 2A, Ecolab, 5 m

2106259 Ethernet cable 5 m, M12 / RJ45, X-coded 20704271 M12 cable, 2A, Ecolab, 10 m

2106260 Ethernet cable 10 m, M12 / RJ45, X-coded 2102509 M12 cable, angled, 2A, Ecolab, 3 m

2094783 Ethernet cable 2 m, angled, M12 / RJ45, 
X-coded

2102510 M12 cable, angled, 2A, Ecolab, 5 m

2094784 Ethernet cable 5 m, angled M12 / RJ45, 
X-coded

1064114 4Dpro connectivity CDB/CDB650

2094785 Ethernet cable 10 m, angled, M12 / RJ45, 
X-coded

1 Assuming a voltage supply of 24 V +15% / –5%. 

Optional accessories
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 C  Detection volume

Visionary-S AP
Working distance 0.5 m ... 6.5 m
Detection angle ~60° x 50°
No. of pixels for 3D 640 x 512 pixels
No. of pixels for RGB 640 x 512 pixels
Light sensitivity < 40 klx (sunlight)
Maximum frame rate 1 ~30 fps
Enclosure rating IP67
Supply voltage 2 24 V +/– 15%
Power consumption 2 19 W / 1.6 A (max.)
Processor (internal) 3 4xARM Cortex A72, 1.2 GHz
Weight 4 1.7 kg (2.2 kg)
Dimensions (L x W x H) 4 162 x 93 x 78 mm (162 x 116 x 104 mm)
Ambient temperature (operation) 3 0 °C ... +40 °C (0 °C ... +50 °C)
Ambient temperature (storage) –20 °C ... +70 °C
Interface Gigabit Ethernet (TCP/IP)
Length of cable max. 10 m
Protection class III
Laser protection 5 Class 1 (λ: 808 nm, P0 ≤ 4 mW, t ≤ 10 ms); 

EN/IEC 60825-1:2007, IEC 60825-1:2014, EN 60825-1:2014+A11:2021 
Shock resistance According to EN 60068-2-27:2009
Vibration resistance According to EN 60068-2-6 and 60068-2-64
Electromagnetic compatibility (EMC) EN 61000-6-2:2005-08

EN 61000-6-4:2007-01 
1 Certain settings require lower frame rates.
2 Voltage supply must be able to bridge a brief power outage of 20 ms as specified in IEC 60204-1.
3 �Part of the processor resources are required for internal processing. The current processor load is displayed in the CPU monitor in SICK 

AppStudio.
4 The values are for housing variants with long cooling fins.
5 Conforms to 21 CFR 1040.10 except for deviations per Laser Notice No. 56 of May 8, 2019, and subsequent versions.

The detection volume depends on the:

b	Configuration;

b	Distance to a flat boundary surface, e.g., floor, ceiling, wall

b	Mounting bracket relative to the boundary surface

The maximum detection distance – and therefore the 3D detection 
volume – also depends on environmental influences:

b	Lighting conditions

b	IR interference

b	Air particle concentration

b	Remission properties (808 nm) of the objects in the detection 
zone

b	Object transparencies (e.g., windows)

Note:	� The reliability of the detection is reduced by heavily 
reflective or absorbent materials (e.g. mirrors, black 
surfaces).

Absolute measurement accuracy (∆z-axis) and 
repeatability (σz) at 90% remission factor and without 
background light

Working 
distance (z)

Measurement 
accuracy1 ∆z 

Repeatability1 σz

0.50 m < 1.5 mm ± 0.25 mm

1.00 m < 2.5 mm ± 0.6 mm

1.50 m < 3.0 mm ± 1.5 mm

2.00 m < 4.5 mm ± 2 mm

2.50 m < 6.0 mm ± 4 mm
1  �Average in the middle of the field of view at 90% remission factor 

at 25 °C

Detection volume and 2D measuring ranges

Δx

Δy

z

Absolute working 
distance (z)

Measuring range  
(∆x x ∆y)

Pixel size 

0.50 m ~ 45 cm x 45 cm ~ 1 mm x 1 mm

1.00 m ~ 100 cm x 90 cm ~ 2 mm x 2 mm

1.50 m ~ 160 cm x 130 cm ~ 3 mm x 3 mm

2.00 m ~ 220 cm x 180 cm ~ 4 mm x 4 mm

2.50 m ~ 280 cm x 230 cm ~ 5 mm x 5 mm

Pin Signal Description
1 GND Reference potential

2 24 V DC +/– 15% 
for 10 m cable length: 
24 V DC 
+ 15 /– 5%

Supply voltage

3 CAN L Reserved, not executed.  
DO NOT connect to VCC!

4 CAN H Reserved, not executed.  
DO NOT connect to VCC!

5 TD+ (RS-422/485) Host Reserved, not executed.  
DO NOT connect to VCC!

6 TD- (RS-422/485) Host 
TxD (RS-232), Host

Reserved, not executed.  
DO NOT connect to VCC!

7 TxD (RS-232), AUX Only service

8 RxD (RS-232) AUX Only service

9 SENS GND Reference potential for 
electrically decoupled inputs

10 SENS IN1 Digital input, HW Trigger IN, 
electrically decoupled

11 RD+ (RS-422) Host Reserved, not executed.  
DO NOT connect to VCC!

12 RD- (RS-422/485) Host 
RxD (RS-232), Host

Reserved, not executed.  
DO NOT connect to VCC!

13 INOUT 1 Programmable digital I/O

14 INOUT 2 Programmable digital I/O

15 SENS IN2 Digital input, electrically 
decoupled

16 INOUT 3 Programmable digital I/O

17 INOUT 4 Programmable digital I/O, 
flash synchronization

Pin Signal

1 TRD0_P

2 TRD0_N

3 TRD1_P

4 TRD1_N

5 TRD3_P

6 TRD3_N

7 TRD2_P

8 TRD2_N
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Pin Flex color1

1 Blue 

2 Brown 

3 Green 

4 White 

5 Pink 

6 Yellow 

7 Black 

8 Gray 

9 White + black 

10 Violet 

11 Gray + pink 

12 Red + blue 

13 White + green 

14 Brown + green 

15 White + yellow 

16 Yellow + brown 

17 White + gray
1  �Only applies for the cables listed here (see optional acces-

sories).
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1 Power connection/digital inputs and outputs/service
2 Device indicator
3 Application indicator
4 Ethernet status indicators
5 Ethernet port
6 M6 threaded hole, 7�mm deep (2x), for mounting
7 Service interface
8 Coordinate system origin
9 Bracket interface
ß Bracket attachment

1 Power connection/digital inputs and outputs/service
2 Device indicator
3 Application indicator
4 Ethernet status indicators
5 Ethernet port
6 M6 threaded hole, 7�mm deep (2x), for mounting
7 Service interface
8 Coordinate system origin
9 Bracket interface
ß Bracket attachment
à M6 threaded hole, 10�mm deep (3x), for mounting


